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Overview
RGB Editor is a small utility useful for selecting and creating RGB colors for programming projects. The values of the red, green 
and blue components are displayed and easily transferred to your source code files. Custom colors can be defined and saved 
for use in other coding projects. Custom colors swatches can also be copied to the clipboard.

Desktop Locations
RGB Editor’s location on the desktop is saved when the program is exited. Whenever you start RGB Editor it will reappear on 
the desktop where you last placed it. RGB Editor property sheet locations are also stored and reused the next time they are 
opened.

Taskbar Tray
RGB Editor for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray. This 
option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing RGB Editor
Installation
To install RGB Editor for Windows 95/NT on your computer simply create a new, empty folder and place the files; RGB.EXE, 
RGB.HLP and RGB.CNT there.

RGB.EXE - The RGB Editor Application
RGB.HLP - The Windows 95/NT Help File
RGB.CNT - The Help Contents File

To integrate RGB Editor for Windows 95/NT with the MS Windows Explorer select the RGB Editor Explorer Setup property sheet
while RGB Editor is running.

Note If you have an earlier version of RGB Editor for Windows 95/NT installed on your computer, simply replace the RGB.EXE, 
RGB.HLP and RGB.CNT files with the newer versions.

Note The RGB.INI file is no longer used and can be deleted. The various application settings specified in the RGB Editor 
Options property sheet as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT
System Registry.

Note Some earlier versions of RGB Editor for Windows 95/NT included a RGB.WRI documentation file. This file has been 
replaced by the RGB.HLP file and can now be deleted.

Warning If you rename the RGB.EXE file you must also rename the HLP file using the same basename. For example if you 
change the RGB Editor application file name to NewName.exe, rename the help file to NewName.hlp. Do not rename the 
RGB.CNT file however. The HLP and CNT files must reside in the same folder as the RGB Editor application file itself.



Configuring RGB Editor
RGB Editor Options
Select the File | Options menu item to display the RGB Editor Options property sheet. This window will allow you to change the 
various RGB Editor program settings listed below.

Launch Multiple Instances
Check this item to allow more than one instance of RGB Editor to be run on the desktop.

Place Icon in Taskbar Tray
Check this item to display a small RGB Editor program icon in the Taskbar Icon Notification Tray. If this item is selected and 
the RGB Editor window is minimized a button will not be added to the Taskbar, to restore the RGB Editor window on the 
desktop press the small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running 
programs.

Note When this option is selected, clicking on the Close box in the upper right-hand corner of the window title bar will 
minimize RGB Editor instead of closing the application. To quit RGB Editor right-click with your mouse on the RGB Editor icon 
in the Taskbar tray. You may also use the File | Exit menu command or the Ctrl+Q keyboard shortcut.

Confirm Program Exit
Check this item to confirm quitting RGB Editor for Windows 95/NT. When this option is selected you will be prompted to 
confirm your intention to exit RGB Editor and return to the MS Explorer desktop. This item is useful if you run RGB Editor from
the tray and wish to avoid accidental exits when you right-click on the RGB Editor tray icon.

Select the Type of Macro to be Copied to Clipboard
Select the types of macro to be copied to the clipboard. This setting allow you to specify the text format for the RGB macro 
that is copied to the MS Windows Clipboard. This macro can then be copied into your program project source code or HTML 
file.

RGB Macro
Select this type to copy the currently selected color definition in the RGB (128,128,128) format. This format is useful for 
Visual BASIC and some C Language source code files.

Hexadecimal
Select this type to copy the currently selected color definition in the 0x00808080 format. This format is useful for Visual C 
and Assembly Language source code files.

HTML Macro
Select this type to copy the currently selected color definition in the "#808080" format. This format is useful for most HTML 
file editors.

Specify the Color Swatch Size for Clipboard Copies
The currently selected RGB color can be copied to the MS Windows Clipboard as a small rectangular bitmap suitable for 
pasting into a graphics editing utility. Use the setting described below to specify the size of the color swatch to be copied to 
the Clipboard.

Width
Use this entry field to specify the width (in pixels) of the color swatch. The color swatch width can be between 8 and 256 
pixels.

Height
Use this entry field to specify the height (in pixels) of the color swatch. The color swatch height can be between 8 and 256 
pixels.

Camera Shutter Sound when Copying
Check this box to play an SLR camera shutter sound when copying RGB Macro or Color Swatches to the MS Windows 
Clipboard.

Sounds with Warning Dialog Boxes
Check this box to play a short beep sound when RGB Editor displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of RGB Editor program options. When you press this button the 
RGB Editor Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the RGB Editor Options property sheet without making any changes. If you have made any changes
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.



Help
Press this button to open the RGB Editor Help window and go directly to the Configuring RGB Editor topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the RGB Editor 
Options window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



RGB Editor Explorer Setup
RGB Editor Explorer Setup
Select the Help | Setup menu item to display the RGB Editor Setup property sheet. This window will allow you to integrate RGB 
Editor for Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and remove MS Explorer 
shortcuts.

Create a Start Menu Item
Check this item to create a RGB Editor Start Menu entry. The RGB Editor for Windows 95/NT program will be located in the 
Software by Design folder on the Programs menu. This item will be disabled (grayed) if a RGB Editor item already exists in 
the Software by Design folder.

Remove this Start Menu Item
Check this item to remove the RGB Editor entry located in the Software by Design folder on the Programs menu. This item will
be disabled (grayed) if a RGB Editor item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a RGB Editor for Windows 95/NT program icon on the Explorer desktop. This item will be disabled 
(grayed) if a RGB Editor desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the RGB Editor for Windows 95/NT program icon from the Explorer desktop. This item will be 
disabled (grayed) if a RGB Editor desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run RGB Editor for Windows 95/NT whenever Microsoft Windows is started. This option 
creates a RGB Editor program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a RGB 
Editor startup item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove RGB Editor from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
RGB Editor startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the RGB 
Editor Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the RGB Editor Explorer Setup property sheet without creating or removing any MS Explorer 
shortcuts.

Help
Press this button to open the RGB Editor Help window and go directly to the RGB Editor Explorer Setup topic.



Using RGB Editor
Using the RGB Editor
The RGB Editor displays the currently selected color in the viewing region at the top of the main window. Three slider controls 
are provided directly beneath this region.

Use these slider controls to adjust the Red, Green and Blue components of the color you wish to create.

Each of the slider control values can be adjusted from between 0 and 255. As adjustments are made to these controls the 
resulting color combination will be automatically displayed directly above.

Tip Double-Click your mouse on the color region of the window to quickly open the standard MS Windows Color Editing dialog 
box.



File Menu
File Menu Commands
The File menu provides commands to configure the RGB Editor. A short description of each item follows:

Options
Opens the RGB Editor Options property sheet and allows you to change RGB Editor program settings. Use this command 
to configure the RGB Editor program.

Exit
Closes the RGB Editor program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this 
command.

Tip Commonly used File commands can be invoked using shortcut keys.



Edit Menu
Edit Menu Commands
The Edit menu provides commands used to edit the contents of RGB Editor documents. A short description of each item follows:

Copy
Copies the current color selection to the Clipboard as a programming text macro. The Ctrl+C shortcut can be used for this 
command.

Copy Swatch
Copies the current color selection to the Clipboard as a small color swatch bitmap. The Ctrl+S shortcut can be used for this
command.

Edit Colors
Use this command to open the standard MS Windows Color Selection dialog box. The Ctrl+E shortcut can be used for this 
command.

Tip Commonly used Edit commands can be invoked using shortcut keys.



View Menu
View Menu Commands
The View menu provides commands used to change RGB Editor display options. These items provide a means of changing the 
RGB Editor window appearance. A short description of each item follows:

Minimize
Minimizes the RGB Editor window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the RGB Editor window top most on the desktop. When this item is checked the RGB Editor 
window will float above all other non-topmost windows on the desktop. This item is useful if you normally run RGB Editor 
with a small window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this 
command.

Tip Commonly used View commands can be invoked using shortcut keys.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with RGB Editor operations. A short description of each item follows:

Contents
Opens the RGB Editor Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens RGB Editor Help and displays the Search window. You can use this window to search for specific RGB Editor help 
topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Register
Displays the RGB Editor Shareware Registration Wizard. This wizard allows you to register    RGB Editor for Windows 
95/NT for authorized use.

Setup
Displays the RGB Editor Explorer Setup property sheet. This window provides options to integrate RGB Editor with the MS 
Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software by Design web site on the Internet.

About RGB Editor
Displays the RGB Editor splash box. This window contains program information, the current version of RGB Editor you are 
running and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke RGB Editor menu commands without first displaying the menu and then selecting an 
item from it. The most commonly used RGB Editor commands can be invoked using the following shortcut keys.

File Menu
Ctrl+Q Exit RGB Editor, and return to the desktop

Edit Menu
Ctrl+C Copy color macro to the Clipboard
Ctrl+S Copy color swatch to the Clipboard
Ctrl+E Open the MS Windows Color Editor

View Menu
Ctrl+Y Minimize RGB Editor to a button or icon
Ctrl+T Make the RGB Editor window topmost

Help Menu
F1 Display this Help file



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in RGB Editor for Windows 95/NT please feel free to contact me on 
CompuServe.

Gregory Braun
CompuServe: 71613,2175
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



Release History
RGB Editor for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added facility to edit colors by double-clicking the mouse directly in the color window. 

v2.3 Added option to place the program icon in the taskbar notification tray. Added an SLR Camera shutter sound option 
when copying to the MS Windows Clipboard

v2.4 Added HTML color macro option and the Minimize item to the View menu.

v2.5 Replace custom color controls with the standard MS Windows trackbar controls. Fixed HTML color triplet ordering bug.

v2.6 Added support for screen color settings as specified in the Display Properties dialog box. Added default user and 
company name to the splash box.

v2.7 Moved all RGB Editor options and settings to the MS Windows 95/NT System Registry. Added an MS Windows 95/NT 
Help file. Added an automatic Explorer Setup facility.

v2.8 Converted the RGB Editor Options dialog box to a three-tab property sheet. Fixed a bug that prevented proper window 
repositioning when the MS Explorer Taskbar was placed along the left edge or at the top of the desktop and the Auto 
Hide option was active.

v2.9 Fixed a bug that prevented proper text display when large systems fonts where used.

v3.0 RGB Editor now behaves like a true Taskbar Tray application. Fixed several minor bugs.

Last Update  March 11th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



System Registry
RGB Editor for Windows 95/NT System Registry Key
RGB Editor for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are 
updated automatically while RGB Editor is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. RGB Editor automatically updates registry entries when it 
exits. If you edit these settings make sure RGB Editor is not running while you edit them. If RGB Editor is currently running your 
changes will be overwritten when RGB Editor exits.

RGB Editor for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
RGB Editor for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. RGB Editor will automatically maintain these settings for you. If you 
do edit these, you do so at your own risk.



Removing RGB Editor
Removing RGB Editor for Windows 95/NT
If you find that RGB Editor for Windows 95/NT does not meet your needs you can remove it from your computer system by 
simply deleting the following files from your hard drive. All of these files will be located in the folder that you originally installed 
RGB Editor in.

rgb.exe RGB Editor for Windows 95/NT application program.
rgb.cnt RGB Editor Help Topics File
rgb.hlp RGB Editor Help File

If you have opened and used the RGB Editor for Windows 95/NT Help files your system may contain the following two (2) files. 
These files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely 
removed.

rgb.gid MS Windows Help settings file. This file contains the RGB Editor Help window size and desktop location as 
well as any bookmarks you may have created.

rgb.fts MS Windows Help word database. This file is created when you build a custom word list for RGB Editor 
Help files. This file is used to search for words and phrases in the RGB Editor Help files.

RGB Editor for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above 
from your system’s hard drive you will have completely removed RGB Editor from your computer system.

Note If you have installed RGB Editor shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the RGB Editor files mentioned above.



Software by Design Web Site
Software by Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software by Design web site.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"RGB Editor for Windows 95/NT v3.0"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering RGB Editor for Windows 95/NT
Registering RGB Editor
RGB Editor for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use RGB Editor for Windows 95/NT you are required to register it. If after evaluating RGB Editor for 30 days you 
decide not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register RGB Editor for Windows 95/NT by mailing the Order Form provided with this software. When you register RGB 
Editor for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration 
code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when RGB Editor for Windows 95/NT is first launched.

To register your copy of RGB Editor for Windows 95/NT select the Help | Register menu command. The Shareware Registration
Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered RGB Editor for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered RGB Editor for Windows 95/NT. If you did not 
specify an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased RGB Editor for Windows 95/NT. Refer to the notification 
letter that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered RGB Editor for Windows 95/NT. When you successfully register 
your copy of RGB Editor this box will automatically be unchecked for you. If you wish to see the splash box when RGB Editor 
is launched return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete RGB Editor for Windows 95/NT 
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the RGB Editor Help window and go directly to the Registering RGB Editor topic.



Purchasing Information
Purchasing Information
RGB Editor for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use RGB Editor for Windows 95/NT you are required to register it. If after evaluating RGB Editor for 30 days you 
decide not to purchase it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register RGB Editor for Windows 95/NT by mailing the Order Form provided with this software. When you register RGB 
Editor for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration 
code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when RGB Editor for Windows 95/NT is first launched.

Single User Licensing
Individual users can register RGB Editor for Windows 95/NT for $20.00 dollars. If you would also like a 3 ½” floppy disk sent to 
you please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can 
always download the latest release of RGB Editor directly from the Software by Design web site on the Internet. Print the RGB 
Editor for Windows 95/NT Order Form and mail it with your check to become a registered user of RGB Editor for Windows 
95/NT.

Site Licensing
RGB Editor for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to install and 
use RGB Editor on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy 
disk and entitles you to unlimited free updates and telephone support. You can always download the latest release of RGB 
Editor directly from the Software by Design web site on the Internet. Print the RGB Editor for Windows 95/NT Order Form and 
mail it with your check to become a registered user of RGB Editor for Windows 95/NT.

Corporate Licensing
RGB Editor for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install 
and use RGB Editor on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” 
floppy disk and entitles you to unlimited free updates and telephone support. You can always download the latest release of 
RGB Editor directly from the Software by Design web site on the Internet. Print the RGB Editor for Windows 95/NT Order Form 
and mail it with your check to become a registered user of RGB Editor for Windows 95/NT.



RGB Editor for Windows 95/NT Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

To order by check, send this order form and a check to:

Gregory Braun
5609 West Hadley Street
Milwaukee, WI    53210-1554 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of RGB Editor for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of RGB Editor for Windows 95/NT may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not 
both.

Site License
Any number of users at a single location may access the registered version of RGB Editor for Windows 95/NT through a 
network, provided that you have obtained a site license for the software covering all workstations that will access the software 
through the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of RGB Editor for Windows 95/NT through
a network, provided that you have obtained a corporate license for the software covering all workstations that will access the 
software through the network. Any number of users at any number of locations can install and use the software on one or 
more computers or workstations.

Software Updates
Registered users of RGB Editor for Windows 95/NT are entitled to unlimited free program updates. Software updates can be 
downloaded directly from the Software by Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.




